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1 Introduction

1.1 About the Manual

To facilitate the operation of users, all the parameters of the converter GT100-DP-RS, application methods and

cautions are described in this document. Please carefully read this document before operating this unit.

1.2 Copyright

The data and cases mentioned in this manual shall not be copied without authorization. SST automation may
upgrade the product and revise the user manual during the development process of the product without notifying

users.

SS I(@le is the registered trademark of SST automation.

The product has many uses. Users must make sure all operation steps and results conform to the safety regulations

of relevant field including legal and technical requirements.

1.3 Related Products

Related products including: GT200-DP-RS, GT200-HT-RS etc.
To obtain the user manual of the products above, please access the company website www.sstcomm.com or send

E-mail to support@sstcomm.com.

1.4 Glossary

PROFIBUS DP PROFIBUS DP protocol

RS232/RS485/RS422 Fieldbus interfaces which are able to operate various communication protocols, e.g.
UART.

RS-25 RS232 / RS485 converter

WWW.SSTCOMM.COM 4 SS (@lvlvl
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2 Product Overview

2.1 Product Function

Converter GT100-DP-RS implements data communication between serial port and PROFIBUS DP. Four serial
devices can be connected to PROFIBUS DP network and converted to PROFIBUS DP network devices.

GT100-DP-RS has RS232/RS485/RS422 serial interface, which can be specified by the user when purchasing.

2.2 Product Feature

>  Wide application: All devices based on modbus protocol with RS485/RS232/RS422 interface are able to be
connected to PROFIBUS DP network through GT100-DP-RS. Such as frequency converters with Modbus
protocol interface, motor start-up protector, intelligent high/low-voltage electrical apparatus, measuring
devices, transmitters, intelligent field measuring instruments, etc.

> Easy implementation: Users do not need to know the technical details of PROFIBUS and Modbus, just
complete configuration as required refer to this manual and the application cases, connection and
communication can be realized in a short time without complex programming.

» Transparent communication: Users can establish transparent data communication between PROFIBUS DP
and Modbus according to the mapping relationship between PROFIBUS DP data communication area and

Modbus data communication area.

2.3 Technical Specification

[1] GT100-DP-RS acts as a PROFIBUS DP Slave at the side of PROFIBUS DP, while it acts as a Modbus Master

or universal mode at the side of serial port;

[2] When GT100-DP-RS acts as a Modbus Master at the side of serial port:

»  Transparent communication between PROFIBUS DP and Modbus can be established through the mapping
relationship between PROFIBUS DP data communication area and Modbus data communication area;

» O01H, 02H, 03H, 04H, 05H, 06H, OFH and 10H functions are supported;

WWW.SSTCOMM.COM 5 SS (@lvlvl



GT100-DP-RS
Serial/PROFIBUS DP Converter

User Manual

»  Up to 48 Modbus commands can be configured;
» Modbus function codes 03H and 04H support function of “Byte-Swapping”, which can easily solve the
problem of large-end and small-end format between two networks;
[3] When GT100-DP-RS is set in universal mode, the control modes of time interval between characters, frame
length and delimiter are supported with automatic transmission function;
[4] Completes PROFIBUS DP VO slave functionality according to EN50170 (IEC61158): Measuring and control
digital data communication industrial control system by using the third part of field bus: PROFIBUS standard;
[5] As a PROFIBUS DP slave: automatic baud rate detection on PROFIBUS DP (9600 bit/s ~ 12 Mbit/s);
[6] PROFIBUS input/output bytes number can be free to set through STEP7, the maximum number of bytes:
(DMax Input Bytes <244 Bytes
(@Max Output Bytes <244 Bytes
(3Max Data Bytes <488 Bytes
[7]Max Module: 50
Modules: Status/Control (Optional)—Occupy one input-byte and one output-byte.
Bit 0 of input-byte: Serial device fault indication, 0 indicates that there is no fault in Modbus Slave, 1 indicates
that there is fault with Modbus Slave. The other 7 bits are reserved.
Bit 0 of output-byte: Set 1 to hold the fault status of device, set 0 to refresh the status of Slave in real time, the
other 7 bits reserved.
Notes: this module is only valid on the mode of Modbus master!
4 Words Input, 4 Words Output
8 Words Input, 8 Words Output
16 Words Input, 16 Words Output
32 Words Input, 32 Words Output
64 Words Input, 64 Words Output
1 Byte Input
1 Word Input
8 Words Input

1 Byte Output

6 SSTew
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1 Word Output

8 Words Output

2 Words Input Consistent

4 Words Input Consistent

8 Words Input Consistent

16 Words Input Consistent

2 Words Output Consistent

4 Words Output Consistent

8 Words Output Consistent

16 Words Output Consistent
When using “Status /Control (Optional)” module in STEP7 configuration, putting it at the bottom of all data
modules is a better choice.
The Module will occupy one input byte and one output byte of GT100-DP-RS memory mapping, if you put it at
the top of the memory or in the middle of the memory, you should reserve the input and output bytes when you
configure Modbus parameters in SST-MP-CFG;
[8] Serial port is able to support 3 models of electrical interfaces: RS232, RS485 and RS422;
[9] Multiple formats of serial port communication parameters are supported. Baud rate: 300, 600, 1200, 2400,
9600, 19200, 38400, 57600, 115200bps can be selected. Parity check mode: None, Odd, Even, Mark and Space
can be selected;
[10] Power supply: 24VDC (11V~30V), 80mA (24VDC);
[11] Working temperature: -40°F ~140°F  (-40°C~60°C), Humidity: 5%~95%;
[12] External dimensions (W*H*D): 0.98 in*3.94 in *3.54 in (25mm*100mm*90mm);
[13] Installation: 35mm DIN rail;

[14] Protection Level: IP20;
[15] CE marked.

WWW.SSTCOMM.COM 7 SS (@lvlvl
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3 Hardware Descriptions
3.1 Product Appearance
Power Interface | Button
Indicators
MINI B Model
USB Interface
LED: Display
DP Address
PROFIBUS DP
interface

RS232 Interface %

RS485/RS422 Interface

SSTem
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3.2 Indicators

Indicator Status Description
Green Blinking PROFIBUS DP is communicating
SiA Green Off No data communication
Red On PROFIBUS DP communication fails
PR Red Off Normal data communication
Green Blinking Serial port is receiving data
KA Green Off No data receiving
Green Blinking Serial port is sending data
= Green Off No data sending

3.3 Button and LED

»  Button: 1. Mode switch. 2. Modify the PROFIBUS DP address.
» LED: Display the current PROFIBUS DP address and the configuration state.

The default mode of GT100-DP-RS is normal communication mode after powering on, LED (always on)

displays PROFIBUS DP address.

1) Mode switch: After powering on, LED shows the GT100-DP-RS’s PROFIBUS DP address when acting
as a slave. Long press the button for 5 seconds -> CF blinking; Click the button -> CF on and enter the
configuration mode; Use any one of RS232/RS485/RS422 serial ports to connect to the serial port of PC
(When using RS485/RS422, users need to convert it to RS232 with relevant converter first) in order to
finish configuration uploading and downloading. After downloading, long press the button for 2.5
seconds to enter the normal communication mode; Use USB connector line to connect USB port of
GT100-DP-RS and PC in order to finish uploading and downloading, and choose whether to enter into
the communication mode according to software hints.

2) Modify the address of PROFIBUS DP: After powering on, LED shows the GT100-DP-RS’s PROFIBUS

9 SSTew
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DP address when acting as a slave. Double click the button to enter the PROFIBUS DP address
modifying state, the high bit of DP address starts blinking and low bit is always on. Press the button to
make the number add one; long press the button over 2.5 seconds to change to low bit setting state.
When setting the low bit state, LED high bit is always on and low bit starts blinking. Press button to
make the number add one; long press button over 2.5 seconds to save the new address and enter the
normal communication state, the high bit and low bit of LED are always on.

LED display state block diagram is shown as below:

Power off: LED is off

v Power on
Normal communication
LED CF Long press state: LED high & low bits |
blinking ) is always on and displays
button for
5 PROFIBUS DP address
Click button
L l Double click button
\
Click button
CFon, Z"nﬁg Setting high bit state: LED high bit

fode LED high bit blinking, |—————| number add 1

low bit is always on

Long press button for 2.5s
Long press button for 2.5s

A 4

. ] Click button
Setting low bit state: |——» LED low bit

LED high bit is always |——| pumberadd 1
on, low bit blinking

Long press button for 2.5s

y

Notes: while changing the DP address, LED will automatically recover to normal communication state if

there is no operation of button over 10 seconds, the previous operation is invalid.

WWW.SSTCOMM.COM 10 SS (@IVM
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3.4 Interface

3.4.1 Power Supply Interface

1 |( (@) GND
o
2|1 f\@/\ NC
.
3! f\ﬂ;‘, 24V+
Pin Function
1 GND
2 NC, not connected
3 24V+, DC 24V power positive, range:
9~30V

3.4.2 RS485/RS422 Interface

The RS485 interface of GT100-DP-RS is a standard one. The RS485 characteristic of the product is
described as below:
»  The basic characteristics of RS-485 transmission technology

(DNetwork topology: Linear bus, and there are active bus termination resistors at both sides;

(@Baud rate: 1200 bps~115.2Kbps;

(®Media: Shielded twisted-pair cable and also can cancel the shielding, depending on environmental
conditions (EMC);

@Site number: 32 stations per subsection (without repeater), and up to 127 stations (with repeater).

BPlug connection: 5-pin pluggable terminal.
»  The main points on RS-485 transmission equipment installation

(1) All the equipment are connected with RS-485 bus;

WWW.SSTCOMM.COM 11 SS (@IVM
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(2) There is a bus terminal resistor at each farthest end of the bus—120Q 1/2W to ensure reliable operation
of the network.

Serial interface has 5-pin pluggable terminal and users can wire it according to the instructions on the

panel.
(@) L R
(@) 2. R+
(m) 3: GND
@f— & >
(m) 5. D+
Pin Function
1 R-,RS422 Receive Negative
2 R+,RS422 Receive Positive
3 GND
4 D-, RS485 Data Negative/RS422 Transmit Negative
5 D+, RS485 Data Positive/RS422 Transmit Positive
3.4.3 RS232 Interface
| (@) 1: TX
(@) 2:RX
( (@) 3: GND
\ &/ -
Pin Function
1 TX, GT100-DP-RS serial port transmit, connect

serial receive RX of user device

2 RX,GT100-DP-RS serial port receive, connect serial

WWW.SSTCOMM.COM 12 SS (@MVI
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transmit TX of user device

3 GND

3.4.4 PROFIBUS DP Interface

Shield 4©

sG}—— GND (Pin 5)
PROFI A (Pin 8)

O0O0O0

(@]
G——— PROFI B (Pin 3)
O
(@]

1

O

PROFIBUS DP uses DB 9 hole pattern interface, the pin definition is shown as below:

Pin Definition
3 PROFI_B, Data + (required)
4 RTS
5 GND
6 +5V Output
8 PROFI_A, Data- (required)
Bolt SHIELD

PROFI_B (PIN3), PROFI_A (PINS8) and Shied must be connected; RTS (PIN4) can be used to determine the
transmit direction by some devices; +5V (PIN6) and GND (PINS) are used in the bus termination or as power

supply for Fiber Optical Transceiver (FOT). Maximum output current of PINS and PING is 80mA.

3.4.5 MINI-B USB Interface

5 432 1
]

—%F

WWW.SSTCOMM.COM 13 SS (@IVM
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Pin Definition Description
1 VBUS +5V
2 D- Data Negative
3 D+ Data Positive
4 ID No connection
5 GND Signal Ground

14
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4 Quick Start Guide

The following steps will help users to quickly configure GT100-DP-RS:

1. Connect the power: Wire according to the correct method of connecting power, and be noticed that it’s the
24V DC power. PC and GT100-DP-RS: Connect GT100-DP-RS USB interface to PC USB interface by using
USB cable (USB standard A model to USB Mini B model).

2. Configure GT100-DP-RS: Use configuration software SST-MP-CFG to configure serial port parameters
(subnet) and Modbus read/write command (see chapter 7 Instructions of configuration software). There are two
ways to upload/download configuration of GT100-DP-RS: (1) Use USB cable to configure. Connect the converter
and PC with software SST-MP-CFG installed with SSTCOMM USB cable. Power on the device. Click
upload/download in the software and finish the configuration according to the instruction. After upload/download,
the converter will enter normal communication mode. (2) Use serial port to configure. Connect any one of
RS232/RS485/RS422 serial ports of GT100-DP-RS with PC with software SST-MP-CFG. Power on the device
and LED will show DP address. Long press the button over 5s -> CF blinking. Click the button -> CF on and enter
the configuration mode. Click upload/download in the software, choose correct COM port to finish
upload/download. After upload/download, long press the button over 2.5s to enter the communication mode. It is
suggested to use USB to configure GT100-DP-RS.

3. Modify GT100-DP-RS PROFIBUS DP address: (1) Modifying by software. In configuration software
SST-MP-CFQG, seclect custom for PROFIBUS address in the fieldbus. Write DP address and download the
configuration to the converter. (2) Modifying by button. Double press the button to enter PROFIBUS DP address
setting state (LED high bit is blinking and low bit is on). Click the button to make number add 1. Long press the
button over 2.5s to switch to low bit address setting state. Click button to make number add 1. Long press the
button over 2.5s to save and make new address take effect.

4. Hardware configuration: In PROFIBUS master modeling software, first install GSD file, then drag
input/output module to the slot as required. Compile and download.

5. Connect GT100-DP-RS with serial port devices: According to the instructions of RS485/RS422/RS232

interface in chapter 3, turn off the power and correctly connect the terminals.

WWW.SSTCOMM.COM 15 SS (@IVM
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6. Connect GT100-DP-RS with PROFIBUS DP master station: According to the instructions of PROFIBUS
DP interface in chapter 3, connect at least PIN3 and PIN8 correctly.

7. Power on GT100-DP-RS, then enter the normal communication state.

WWW.SSTCOMM.COM 16 SS (@le
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S Working Principle of Modbus Master Station

The data conversion between Modbus and PROFIBUS of GT100-DP-RS is established by mapping relation.
GT100-DP-RS has two data buffers: one is PROFIBUS network input buffer with address of 0x00-0xF3; the other
is PROFIBUS network output buffer with address of 0x4000-0x40F3. Command 1, 2, 3 and 4 of Modbus write
the data read from Modbus slave station into the network input buffer, then the data will be reading by
PROFIBUS network; Command 5, 6, 15 and 16 of Modbus write the data from the network output buffer into

Modbus slave station. The data saved in network output buffer is the data PROFIBUS master station write to the

GT100-DP-RS.
Input buffer Output buffer
N
> ~H
>  Modbus
Modbus ~ Device 1
Device 1
~
Modbus > Modbus
Device 1 Device 1
U

Users can configure 48 commands. Every command can read a set of continuous Modbus registers.

; SSTew

WWW.SSTCOMM.COM



GT100-DP-RS
Serial/PROFIBUS DP Converter

User Manual

6 Universal Mode

6.1 Data Conversion

The converter implements data conversion between PROFIBUS DP fieldbus protocol and serial port devices
with RS232/RS485/RS422 serial interface. The conversion and transmission between PPROFIBUS DP data and

serial port data is bidirectional. Data conversion block diagram is shown as below:

PROFIBUS DP Bus

PROFIBUS Output Data PROFIBUS Input Data
Eo|i|DIl |D2|...|Di|0O]... Ei|j|Dl|D2|..|Djlo

GT100-DP-RS

Serial Port Output Data Serial Port Input Data
Dl |D2|..|Di Dl | D2 | ... | Dj

User Serial Device

In the block diagram above, “Eo” is the transaction ID of PROFIBUS output data; “i” is the number of serial
port data which needs to be sent contained in output data; “D1” ~ “Di” is the data that GT100-DP-RS converter
send to serial devices; “Ei” is the transaction ID of PROFIBUS input data; “j” is the number of serial port data
which has been received of input data; “D1” ~ “Di” is the data GT100-DP-RS converter received from user serial
devices.

As shown above, no matter what control mode serial port side use, when GT100-DP-RS converter receives a

WWW.SSTCOMM.COM 18 SS (@IVM
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frame of correct data from serial device, the data is packaged as shown above” PROFIBUS Input Data” and
transmitted to PROFIBUS DP master station (normally PLC). If the length of data received from serial port is
shorter than the length of DP conversion data, GT100-DP-RS converter will set other bytes to 0. For example, the
data length of each conversion by DP is 10 bytes. If serial devices transmit 3 bytes data, except 2 frame headers
and the 3 bytes data, GT100-DP-RS converter will set other 5 bytes data to 0 and saved DP data into buffer.

Notice: Control mode of universal mode is valid only for the data transmitted from serial devices to
GT100-DP-RS. GT100-DP-RS only send raw data to serial devices without limited by control mode 1.

After PROFIBUS DP master station sents data to GT100-DP-RS converter, according to the format of
“PROFIBUS output data”, the first byte of DP output buffer is output transaction ID and the second byte is the
length of output data marked as N. If any change happened to transaction ID Bl, GT100-DP-RS converter will
transmit the N bytes data starting from the third byte of DP output buffer [ to serial devices regardless of what
control mode the serial devices use to transmit data to GT100-DP-RS converter. For example, suppose the data
length of DP master station output buffer is 6 bytes and the data sent from DP to GT100-DP-RS converter is
(HEX)10 02 11 22 00 00, which means output data transaction number is 16. The real length of valid data is 2
bytes. Then GT100-DP-RS converter only sent (HEX) 11 22 to serial devices regardless of the control mode is
time interval between characters or delimiter.

Notes:

[1] Control method including time interval between characters, frame length and delimiter.

[2] The data saved in DP input buffer is the data which is sent from GT100-DP-RS converter to DP master station.
The data saved in DP output buffer is the data which is sent from DP master station to GT100-DP-RS converter.
[3] There are two ways to send data through serial port. The default one is transaction ID detection: data is sent
out from serial port when transaction number changed. The other is automatic sending: data is sent out according

to sending period.

, SSTew
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6.2 Universal Mode

6.2.1 PROFIBUS Output Data Format

[Transaction ID] [Serial output data length n] [Serial output data 1] ... [Serial output data n] [0x00] ... [0x00]
— n I —

Notes:
The number of PROFIBUS output bytes should be selected as equal to or more than n+ 2;

m numbers of [0x00] is padding data, n+m+2 equals to the number of PROFIBUS output bytes.
Transaction ID: transaction ID adds 1 means a new frame of data.
Case:
If PROFIBUS input/output byte selected by users is 8 bytes input and 8 bytes output, serial output data
length is 3, data is 01 02 03, and the current transaction ID is 0.

Output data format: [01] [03] [01] [02] [03] [00] [00] [00]

6.2.2 PROFIBUS Input Data Format

[Transaction number] [Serial input data length n] [Serial input data 1] ... [Serial input data n] [0x00] ... [0x00]

= n —A= m -

Notes:
The number of PROFIBUS output bytes should be selected as equal to or more than n+ 2;

m numbers of [0x00] is padding data, n+m+2 equals to the number of PROFIBUS input bytes.
Transaction ID: transaction ID adding 1 means a new frame of data.
Serial input data length: Select “Close” in input data length when configuring fieldbus part in software, it didn’t
show the data length in DP input area. Instead, it showed transaction plus data. Select “Open” and DP input area
shows data length.
Case:

If PROFIBUS input byte selected by user is 8 bytes input and 8 bytes output, serial output data length is 3,
data is 04 05 06, and the current transaction number is 00.

Output data format: [01] [03] [04] [05] [06] [00] [00] [00]
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6.2.3 Frame Type

What is frame type? Frame type is used for GT100-DP-RS converter judging the end of data frame sent from
user serial device.

Frame type includes time interval between characters, frame length and delimiter.

6.2.3.1 Time interval between characters

When user serial device sends data to the GT100-DP-RS converter, the converter will start timing for every
byte that user serial sends out. If the next byte’s arrival time exceeds the set time interval (timeout time),
GT100-DP-RS converter will consider the previous receiving N continuous bytes as a data frame. Then, it will
combine this N or N-2 bytes into one “PROFIBUS input data frame” and send it to the PROFIBUS master. If
users select “use CRC check”, GT100-DP-RS will execute CRC check of the former N-2 bytes: if right, send to
the PROFIBUS master; otherwise discard this data frame.

For example, time interval between characters is set 10ms, no CRC check, input and output bytes length of
PROFIBUS master is 8 bytes. The user serial device will first send out one byte 0x11 first. After GT100-DP-RS
receives Ox11, it will start characters interval timer. If GT100-DP-RS receives next byte within 10ms, it will
restart the character interval timer. Otherwise, it will consider receiving one complete data frame. The data word is
all HEX.

User serial device sends to GT100-DP-RS: 11 22 33 44 55 66

GT100-DP-RS sends to PROFIBUS master: 01 06 11 22 33 44 55 66

User serial device sends to GT100-DP-RS: F1 F2 F1

GT100-DP-RS sends to PROFIBUS master: 02 03 FO F2 F1 00 00 00

When PROFIBUS master sends to GT100-DP-RS: 09 05 00 02 08 45 96 00

When GT100-DP-RS detects that transaction number changed, then it will send to serial device: 00 02 08 45
96

Notes: The data length that GT100-DP-RS sends to the user serial device depends on the data value in

the frame that PROFIBUS sends to GT100-DP-RS.
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6.2.3.2 Frame length

This frame type is suitable for receiving serial data frame of specific length. When receiving bytes from
user’s serial devices, GT100-DP-RS will automatically launch the time interval between characters function.
Under the following two conditions, GT100-DP-RS considers that it has received one frame data:

1. The adjacent bytes received from user serial devices don’t time out; the receiving bytes number is equal

to “frame length”. Or,

2. The bytes received from user serial device characters times out.

When GT100-DP-RS has received one frame data, it will dispose of this frame if data numbers equals to the
set frame length. Otherwise, discard the frame directly. If selecting “Use CRC Check”, it will do the CRC check
first and discard those that didn’t pass the CRC check.

For example, set frame type to “frame length”, the length of characters is 4 bytes, time interval between
characters is 10ms, no CRC check, and input and output bytes length of PROFIBUS master is 8 bytes. If receiving
4 bytes continuously with no characters timeout, GT100-DP-RS will package this frame data into one
“PROFIBUS input data” frame and send it to PROFIBUS master. If characters time out, it will directly discard the
data less than 4 bytes. The data are HEX.

User serial device sends to GT100-DP-RS: 11 22 33 44

GT100-DP-RS sends to PROFIBUS master: 10 04 11 22 33 44 00 00

When PROFIBUS master sends to GT100-DP-RS:

02 06 66 55 44 33 22 11 (the data length is limited by the exchange length of PROFIBUS input and output
bytes)

When GT100-DP-RS detects that transaction number changed, then it will send to serial device:

66 5544332211

Notes: The data length that GT100-DP-RS sends to the user serial device depends on the data value in

the frame that PROFIBUS sends to GT100-DP-RS.

. SSTew
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6.2.3.3 Delimiter

This frame type is suitable for receiving the data frame with fixed frame header and end. It requires user
serial devices first to send one “start byte” to indicate: user serial devices start to send one frame and continue to
send one “end byte” when considering one frame data is over. If users select this frame type, GT100-DP-RS will
automatically launch the characters timeout function.

Under the following conditions, GT100-DP-RS considers that it has received one frame data:

1. No characters timeout happens in the process of receiving bytes; And,

2. One correct “start byte” is received; And

3. One correct “end byte” is received.

Under other conditions, GT100-DP-RS directly discards the incomplete data frame.

For example, set frame type to “delimiter”, “start character” is Oxff, “end character” is Oxfe, “time interval
between characters” is 10ms, and input and output bytes length of PROFIBUS master is 8 bytes., GT100-DP-RS
will receive the data correctly only if user serial devices send FF xx xx xx FE with no timeout. The data are all
HEX.

User serial device sends: FF 11 22 33 44 55 FE

GT100-DP-RS sends to PROFIBUS master: 02 05 11 22 33 44 55 00

When PROFIBUS master sends to GT100-DP-RS: 01 02 61 96 00 00 00 00

When GT100-DP-RS detects that transaction number changed, then it will send to serial device: 6196

Notes: The data length that GT100-DP-RS sends to the user serial device depends on the data value in

the frame that PROFIBUS sends to GT100-DP-RS.
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7 Instructions of Configuration Software

7.1 Notes Before Configuring

SST-MP-CFG is a software based on Windows, and used to configure a variety of fieldbus converter devices.
It can set the related parameters and commands of Modbus and other bus.
This manual mainly introduces the using method of GT100-DP-RS.

Double click the icon to enter the interface of “Select Device Type™:

S5elect Dewice

=elect Type

914

Select "GT100-DP-RS" to enter configuration interface:

5 SSTew
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# GT100-DP-RS Gateway Configuration Software

File(F) Edit(E) View(¥) Help(H)

& - =
; )
] | M o U A & =
New Save Open : Upload Dewrload Mapping Conflict Excel
—— ** || Type of Protocol PROFIBUS Slave
%1 Fieldbus .
% it Humber of Bytes Setting through Hardware Confisuration of PROFIBTS TP
38 Subnet Nurmber of Bytes Setting through Hardware Configuration of PROFIBTS DP
Length of Vahd Input-data Disable
Clear after Twice Faults of Tnput-data Dizable
PROFIBTIS Address iSetting By Hardware

7.2 User Interface

SST-MP-CFG interface includes: title bar, menu bar, toolbar, status bar, equipment section, configuration
section and notes section.

Notes: All the gray part in the software cannot be changed.

N SSTew
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# GI100-DP-RS Gateway Configuration Software

EEX

Equipment section: can choose
the operating targets, including

fieldbus or sub-network and add

the nodes and commands.

.F1le[lil Edit(E) View(¥) Help(H) [
(] & A B Menu bar | Title bar
J L 7
Hew Save Open Dellnd  Upload Dow el
g de 3
%4 Fieldbus .
—@; Subnet
=52 Node(l) Toolbar
Mappmg DITr=7T .0
Number of Byte 0
Byte Swap Mon-e;
Type of Checle (&
Type of Scan
Mnemomc . . .
Configuration section: input

configuration parameters, gray
part can not be modified, while

white part can be modified.

Notes section: The specific explanation to

the nouns appearing in the configuration

and devices to help users to understand

_

and operate.

Toolbar is shown as below:

U H M R E
Hew Save Open DelHode

5

AddCmd

o U A & X

Uplaad Dowrload Mapping Conflict  Excel

Functions separately from left to right are: new, open, save, add nodes, delete nodes, add commands, delete

commands, upload configuration, download configuration, auto mapping, conflict detect and export Excel.

Among them,

(I

- New: Create a new configuration project
—~ Open: Open a configuration project

Q Save: Save the current configuration

k- Add nodes: Add a Modbus slave node

T'-: Delete nodes: Delete a Modbus slave node

= Add commands: Add a Modbus command

Bl Delete commands: Delete a Modbus command
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G Upload configuration: Read the configuration from the module and show it in the software
{»’ Download configuration: Download the configuration from the software to the module

ﬁ Mapping: Used to automatically calculate the mapped memory address without confliction by each

command

@ Conlflict Detect: Detect whether there is conflict in memory data buffer of the converter

=x . . .
D Output Excel document: Output the current configuration to local hard disk and save it as .xIs file

7.3 The Operation of Equipment View

7.3.1 Equipment View Interface
41 Fieldbus
=97 Subnet

== Mode(l)
8 03 Eead Holding Eegister

7.3.2 Operation Mode of Equipment View

The equipment view supports three types of operation: Edit Menu, Edit Toolbar and Right click edit Menu.

LEEERISN View (V1 Help (H)
444 Hode (T)

Tpload (Ctr1+U) 2 53{ Fieldbus
Dowrload (Ctrl+D) é,j W
Export XLS (Ctrl+E) | Add Hode
Auto Mapping (CtrlHh) ‘V E Delete H
Conflict Detect (Ctrl+T) =
Update Config Port 4

Open hddWode elHod:

7.3.3 Operation Types of Equipment View

1) Add nodes: Left click on subnet or existing nodes, and perform the operation of adding a new node. Then

SSTew
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there is a new node named "Node (0)" under subnet. Notes: GT100-DP-RS supports configuring only four
Modbus nodes.

2) Delete nodes: select the node to be deleted, and then perform the operation of deleting node. The node and
its all commands will be deleted.

3) Add commands: Left click on the node, and then perform the operation of adding command to add a
command for the node. The dialog box will be shown as follow:

Currently it supports the command IDs: 01, 02, 03, 04, 05, 06, 15 and 16.

Select the command: Double click the command

S5elect Command El
[

01 Fead Coil Status

02 Read Input Status

03 Read Halding Register
04 Read Input Register
05 Farce Single Coail

D& Preset Single Register
07 Read Exception Status
02 Diagrosis

11 Fetch Comm Event Cir
12 Fetch Comm Event Log
13 Program Controller

14 Poll Contraller

15 Force Multiple Coils

16 Preset Multiple Registers

4) Delete commands: Left-click on the command and perform the operation of deleting command.
5) Rename the node: Left-click on the node that needs to be renamed, and the node can be renamed in the

corresponding configuration view interface
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7.4 The Operation of Configuration View

7.4.1 Interface of Fieldbus Configuration View

In the device view interface, click fieldbus and the configuration view interface are shown as follows:

Configurable items including: input valid data length, PROFIBUS

slave station address.

“Input valid data length”: It’s valid only when subnet protocol type is “User Config”. Open: The first byte of

PROFIBUS input data is used to indicate the length of serial port received data. Close:Thereare no bytes of the

PROFIBUS input data which indicate the length of serial port received data.

“PROFIBUS address™: Two options of “Setting By Hardware” and “Customized” can be selected. “Setting

by Hardware” means modifying the PROFIBUS DP slave address through the top button of GT100-DP-RS;

“Customized” means DP address can be input in the textbox of “PROFIBUS Address”. Notes: the textbox on the

right of “PROFIBUS Address” is editable.

# GT100-DP-RS Gateway Configuration Software
File(F] Edit(E) View(¥] Help(H)

FEX

Length of Valid Input-data
Clear after Twice Faults of Input-data
PROFIRUS Address

T .
) = A o U A s =
Hew Save Open : d Upload Downlead Mapping Conflict  Excel
g * || Type of Protacol PROFIBTUS Slave
ol S‘eb e Number of Bytes Setting through Hardware Configuration of PROFIBUS DP
38 ubnet Nurmber of Bytes Setting through Hardware Configuration of PROFIBUS DP

| Disable

Disable

Setting By Hardware

Setting By Hardware

*| The range of PROFIBUS address:0~99 the default value: 2
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7.4.2 Interface of Subnet Configuration View

1) Set Protocol type to Modbus Master

Configurable parameters include:

Modbus communication baud rate, Data bits, Parity check bit, Stop bits, Transmission mode, Response

timeout, Delay between polls, Polling mode of outputting commands, Scan rate.

Interface of configuration view is shown as follow:

# GT100-DP-RS Gateway Configuration Software

File(F) Edit(E) ¥iew(¥) Help(H)

1 1 2 B k&

o U A & ¢

| Upload Dowrload MWapping Conflict Exesl

9=led

Hew Save Open  AddWode Delfads Addly
—~tge | Protocel Select
41 Fieldbus Band Rate
i Ss et Data Bits
-8R ety o Check Bit
#0103 Read Holding Eegister Stop Bits

Transmissien Mode

Response Timeout(300~6000ms)
Delay between polls(0~2500ms)
Cutput Wode

Titne between two continuous pluses
Scan Rate

Modbus Master
19200

8

Mene

i

RTU

300

0

Change of Value

10

Modbus communication baud rate: 300, 600, 1200, 2400, 9600, 19200, 38400, 57600 and 115200bps to be

selected.

Data bits: 8 bits

Parity check mode: None, odd, even, mark and space are optional.

Stop bits: 1 and 2 are optional.

Transmission mode: RTU and ASCII are optional.

Response timeout: When the Modbus master send commands, the range of the time waiting for response

from the slave is 300~60000ms.
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Delay between polls: After one Modbus command has been sent and has received correct response,,or the
response has timed out, the range of the delay time before next command being sent is: 0 ~ 2500ms.

Output mode:

Modbus writing command (output command) has 3 kinds of outputting modes: Cycle, Forbidden and Change
of Value output.

Cycle: The same with Modbus read command, and output according to the scanning ratio.

Forbidden: Prohibit outputting Modbus write command.

Change of Value: When the output data has changed, it outputs the write command and stop outputting after
receiving correct response.

Scan rate: Ratio of slow scan cycle to fast scan cycle. If the quick scan command sends 10 times, slow scan

command sends 1 time.

2) Set Protocol type to User Config

Configurable parameters include:

Modbus communication baud rate, Data bits, Parity check bit, stop bits, Frame type, Time interval between
characters, Frame length, Start delimiter, End delimiter, Enable auto sending, Period of auto sending, Enable CRC
check.

Interface of configuration view is shown as follow:
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# GT100-DP-RS Gateway Configuration Software =13
File(F) Bdit(E) View(¥) Help(H)

N H 2 B T wm © 30 & 2 =

Hew Save Open tddiode TelWode AddCm Dellmd  Upload Downlead Mappins Conflict  Excel
— * | Protocol Select Tser Config
# Ficldous Baud Rate 118200
38 Subact Data Bits 8
Check Bit Mone
Stop Bits 1
Frame Type | Time Interval between Characters
Time Interval between Characters 10
Frame Length 111
Start delirmiter 0
End delirmter 0
Enable Auto Sending Disable
Period of Auto Sending 1000
Enable CRC Check Dhzable

Modbus communication baud rate: 300, 600, 1200, 2400, 9600, 19200, 38400, 57600 and 115200bps to be
selected.

Data bits: 8 bits.

Parity check mode: None, odd, even, mark and space are optional.

Stop bits: 1 and 2 are optional.

Frame type: It means the method of GT100-DP-RS serial port receiving data frame from user serial devices.
Time interval between characters, frame length and delimiter are available to be selected. For more detail, see
chapter 6.2.3.

Time interval between characters: The interval time among characters while transmitting data. Default
value is 10, users can input the time with a range of 10~60000ms.

Frame length: It’s valid only when the frame type is frame length. Users can input the time with a range of
1~166.

Start delimiter: It’s valid when frame type is delimiter, range: 0~255.

End delimiter: It’s valid when frame type is delimiter, range: 0~255.

Enable auto sending: the mode of GT100-DP-RS serial port sending data to user serial devices. Open and
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close can be selected.

Period auto sending: Default value is 1000, users can input the time with a range of 10~60000ms. It’s valid
only when auto sending is opened.

CRC check: It’s valid when frame type is “time interval between characters” and “frame length”. Open and

close are optional.

7.4.3 Interface of Node Configuration View

Under “Modbus master” mode, in the interface of device view, left click a node, and then configuration

interface is shown as follow:

# GT100-DP-RS Gat eway Configuration Software ‘t_—”E”Y‘
File(F) Edit(E) View(¥) Help(H)

M ¥ ®R Feem € I A &

Hew Save Open fdiliode DelFede  AddCmd Uellmd  Upload Download Mapping Conflict  Execel
— || Slave Address 1
%1 Fieldbus

=12 Subnet
SRR M Tode(1)

B8 03 Read Holding Register

7.4.4 Interface of Command Configuration View

Under “Modbus master” mode, click a command and then configuration interface is shown as follow:
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# GT100-DP-RS Gateway Configuration Software
File(F) Edit(E) View(¥) Help(H)

CEX

] | A4 2 ¢ U A & X
Hew Save Open DelCmd  Upload Dowrload MWapping Conflict  Excel
— || Function Code 3
M fieldbis Starting Address
i 33 f:b;ztde(l) Tumber of Data
103 Read Holding Register] Mapp]I.n,g Address(HEX)
e Mlapping Bit(0-7) 0
Tumber of Byte 1}
Byte Swap Mon-exchange
Type of Checlk CRC
Type of Scan Fast Scan
Inemomc

The starting address of Modbus register: The starting address of register/switching value/loop and so on in
Modbus slave in the range of 0~65535 (decimal). For example, if GT100-DP-RS needs to collect the flow of
certain flow meter, and the flow corresponding Modbus register address is 40035, it should be set to 34. The
address provided by corresponding table of data address of user device may be PLC address or protocol address. It
should be filled with protocol address in SST-MP-CFG. The following table shows the PLC address and

corresponding protocol address examples:

Command PLC address examples Corresponding protocol address
Coil state 00001~00010 00000~00009
Input state 10001~10010 00000~00009
Holding register 40001~40010 00000~00009
Input register 30001~30010 00000~00009

The number of data: The number of register/switching value/coil in Modbus slave device. Notes: The

maximum number of write registers is 45 under ASCII mode.

. SSTew
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The starting address of memory mapping: The starting address of data read from devices or written to the
devices in memory buffer of the module. The devices are the user devices connected at the serial side.

The address range of data mapping in the module memory:

Read command: 0x0000 ~ 0x00F3

Write command: 0x4000 ~ 0x40F3

Users can complete the function of mapping address without conflict by software through “calculate mapping
address automatically”. Notes: When using “auto mapping function”, users need to configure corresponding
Modbus register address and data numbers first.

Mapping bit (0 ~ 7): For the bit operation commands, the position range of start-bit located in byte is 0 ~ 7.

Byte swap: There are three kinds of types: Non-exchange, Double-byte-exchange and four-byte-exchange.
Modbus and PROFIBUS DP byte order is that the most significant bit (MSB) takes precedence. DeviceNet byte
order is that the least significant bit (LSB) takes precedence. Users may need to exchange byte order to get the
correct value.

Type of scan: There are two kinds of scanning mode: quick-scan and slow-scan, meeting the requirements of
users about quick-scan or slow-scan of different commands. Slow-scan is equal to quick-scan being multiplied by

scan ratio. (Configure it in the subnet configuration interface)

7.4.5 Notes View

Notes view displays the explanation of configuration. The notes that show how to configure the starting

address is shown as follow:

Iodbus salve Eegister or cods starting address. The range of the parameter value 15 0 to 65535

7.5 Upload and Download Data

There are two methods to finish upload/download configuration of GT100-DP-RS V4.0. (1) Use USB cable
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to configure; (2) Use serial port to configure. It is suggested to use USB cable to configure GT100-DP-RS.

(1) Use USB cable to configure:

Connect USB port of GT100-DP-RS and that of PC through USB cable. Open configuration software

SST-MP-CFG, power on the converter. Then clicking upload/download button will pop up “Select port: USB1”

dialog box to finish upload/download.

(2) Use serial port to configure:

Connect any one of RS232/RS485/RS422 serial ports of GT100-DP-RS to PC. Open the configuration

software and power on the converter. After powering on the converter, LED shows the DP address. Long press the

button over 5s -> CF blinking. Click the button -> CF on and enter the configuration mode. Then clicking upload

or download will pop up the “Select port: COMX” dialog box to finish upload/download of configuration. After

upload/download, long press the button over 2.5s will enter the communication mode.

Under the default condition, users can configure data for GT100-DP-RS in SST-MP-CFG through USB or

serial port. Select “Edit”>"Update config port”>"serial port”. The figure following shows the details:

G ERREN View (V) Help (H)

Delete Command (L)

I = F
Upload Cted+0y | I 1.11‘1 I:
Dowrl oad (Ctr1+D) Star
Export XLS (Ctrl+E) Hurr
i +
Auto Mapping (Ctr1+M) T"-'TP.II‘.
Conflict Detect (Ctrl+T) Bt —

Update Config FPort USE
v Serial

7.5.1 Upload Data

Select upload data and upload the configuration of the converter to the software.

Configure through USB, as the figure below:
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Serial pott:
TTpload Zancel ]

Or use serial port to configure, as the figure below:

menal port:

Tpload iZancel ]

Click “upload data”. If the upload is done, view interface is as shown below:

SST-MP-CFG
! ‘: Upload successFully!
QK

7.5.2 Download Data

Select download data and download the software configure information to converter devices.
If configuring through USB, the process is:

1. Select USB interface.
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=erial pott:
Download Cancel

2. Click “Download”, then the hint below appears:

1‘—\ IF 'you want o download the configuration to the Firmware?

o ]

3. Click ”YES” and start downloading. After downloading, the hint below appears:

\g‘) GT100-DP-RS in the configuration state, whether to use the new configuration into the communication state?

Yes | No |

4. Click “YES”, then configure software prompt download successful.

SST-MP-CFG (x|

! E Download successfully!

QK

If configuring through serial port method, as the figure below:
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=erial pott:

Download Cancel |

Click “Download”. If download is successful, the view interface is as shown below:

SST-MP-CFG B3

! "': Download successfully!

QK

Notes: Before downloading, please make sure all the configurations are completed.

7.6 Open and Save Configuration

7.6.1 Save Configuration Project

Select “Save”, or directly click “Save” in the tool bar the configuration project can be saved as .xml

document.

SN Edit (E)  View (¥)

Hew (H) Ctr1+H
Open(O). .. Cirl+0
Sawe Az (h). .

Recent File

Exit (}X)
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7.6.2 Open Configuration Project

Select “Open”, or directly click “Open” in the tool bar the configuration project can be saved as .xml

document.
IERNIEE Edit (E)  View (V)

Hew (H) Cirl+H
Opern (D). . . Ctrlt0
Save (5] Ctrlts
Sawe Az (A). ..
Becent File
Exit (¥

7.7 Export Excel

Excel document helps users to examine the configuration related.

. i .
Choose the icon D , save the configuration as a excel document under the proper path.

Save Az E E|
Savein | [ Deskiop o W
JM? Documents
H‘_\.})H | 1§ My Computer
ecenl |
DP ; Wty Network Places
Deskton
My Ducurmts
My Computer
Y File name: . :J I Save I
MyNetwork  Saveastype  |Excel Fiel".) | Cancel |
Places
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Double click the .xIs document and open it. It contains 3 parts of “Command List”, “Fieldbus” and “Subnet”.

Subnet: Modbus subnet parameters, as follow:

e | 8 | e |p| & |r| 6 | B | 1 | i | K | L |
Serial Protocol Baud Data Parity Stop Slawe | Transmizsi Responze Delay between | Polling mode of | Pulse | Scan
1 | number | type rate bits | check  bit address on mode @ timeout | polls | outputting order ratio ratio
Modbus= Change-of — ztate
2 1 | Master 19200 8 None | 1 | | RTO | 300 | 1] | output | 10
3
4
5 _
M 4 » M|\ Subnet {Fieldbus’ Order List/ |« |
Fieldbus: Bus type and relevant parameters, as follow:
A | B | c | D | E | F |
Communication Clear after twice faults of
1 | Bustype | Address baud Tnput byte | Chatput byte inputioutput data
Setting through Step 7 Setting through Step 7
2 | Profibus configuration _ configuration Turn on
3
M 4 b wSubnet’ Fieldbus {Order List/ |
Command List: Modbus commands list, as follow:
/O - <7 [ (-l [ ) I I |
Slawe Cirder Starting Data Evte | Mapping
1 | Mumber = address = number = address  number = number | address Bt offset | Scanratio
2 1 1 3 ] 10 0H Fast scanmn
3 2 1 16 1] 10 20 4000H I _I
4
o | |
M4 M Submet {Fieldbus fOrder List/ |% | ¥
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8 How STEP7 Read and Write Converter Data

The data modules of full length supported by GT100-DP-RS are shown below:

2 Words Input Consistent
4 Words Input Consistent
8 Words Input Consistent
16 Words Input Consistent
2 Words Output Consistent
4 Words Output Consistent
8 Words Output Consistent

16 Words Output Consistent

Packing method is used in data sending and receiving in STEP7 programming. The packing method mainly

use SFC15 (pack sending) and SFC14 (pack receiving).

“DFED_DAT”
—  IEW ENG
Wi 16#0 | LADDR FET VAL MWD
P#DE100,
DEX0. O
RECORD |-BYTE 16
SFC14
“DPWE_DAT"
EN ENO
Wit 16#0 —|LADDR RET VAL (MWEO
P#DE100,
DEX0. O
BYTE 16 —EECORD
SFC15
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Caution: It is strongly recommended that use complete-length data module to ensure the integrity of
serial port frame while using universal mode of serial port protocol.
The data modules of word integrity supported by GT100-DP-RS are shown below:
4 Words Input, 4 Words Output
8 Words Input, 8 Words Output
16 Words Input, 16 Words Output
32 Words Input, 32 Words Output
64 Words Input, 64 Words Output
1 Word Input
8 Words Input
1 Word Output
8 Words Output
Users can apply “MOVE” command to read and write data in STEP7 programming.
The data modules of byte integrity supported by GT100-DP-RS are shown below:
Status/ Control (Optional)
1 Byte Input
1 Byte Output

Users can apply “MOVE” command to read and write data in STEP7 programming.
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9 Installations

9.1 Machine Dimension

Size: 0.98 in (width)*3.94 in (height)*3.54 in (depth)

0.98(25mm)

OO0
OXO)
OXO) 1

3.94 (100mm)

L

1.38(35mm)

-
s

Al occoo -
U Q
St oooooﬂ~

3.54 (90mm)

WWW.SSTCOMM.COM 44 SS (@le



GT100-DP-RS
Serial/PROFIBUS DP Converter

User Manual ]

il

9.2 Installation Method

35mm DIN Rail mounting

Install the converter

13

Unload the converter

J11

IN
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10 Maintenance & Cautions

»  No heavy stress to avoid damaging the panels.

»  No collision to avoid damaging the internal components.

» The voltage of power supply should be in the voltage range given by user manual to avoid burning the
module.

»  Prevent the module from water

»  Make sure the connection is correct before power on.
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Appendix A: Using STEP 7 to Set PROFIBUS-DP

The following shows how to use STEP7 to configure GT100-DP-RS:

First of all, copy *. gsd file to the following path: Step7\S7data\gsd\

1. Open SIMATIC Managera‘ﬁ :

I ISIMATIC Manager - =lolx
File PLC Wiew Options Window Help

Do |87 | % @)%

Figure 1

2. Click File->New, and create a new file:

K JSIMATIC Manager
e PLC Wiew Optons ‘Window  Help

Dw 27| %@

New Project ﬂ

User proj eéf_s‘l]’_ﬁ.ht‘ari ez I Muif;i.proj.gc:hs |

Nama.' Sto‘r'ggs path

[T &dd o current multiproject
Hame:  Dope:
ITJHDDBUSl | Project VI

[T E Library

'S_torag\e'.‘locetron

ID:\Program Files‘Siemens'StepThsTprej Browse. ..

¢  Caneel | Help
A

Figure 2
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3. Click Insert->Station-> SIMATIC 300 Station:

KJSIMATIC Manager - T_MODBUS _(oi x|
File Edit Insert PLC View Options Window Help

D (825 ¢ B8 |dls Balta]nE
Z5 T_MODBUS -- D:\Program Files',Siemens',Step 7', s7proj!
MENET (1) SIMATIC 300 (1)

[<¥e Filter > ;|Y¢|%§|%Em_|\?|

IO x|

il SIMATIC 30001

Figure 3
4. Open S7 PLC hardware configuration: SIMATIC 300(1) ->Hardware, and double-click:
=k

Flle Edt Insert PLC View Options Window Help
E [ |] < Mo Filter > A% |BE BEMN

D |2 2Rldale =0

& T_MODBUS -- D:'Program Files'Siemens’,Step74s7projiT_MODE_1

-lolx|

“{ff] STMATIC 3000(1)

Figure 4

5. Choose Option->Update Catalog in the menu, update GSD in Device catalog
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HY Comfig - ISTHATIC 300 (1) (Configurstionl — T_EODETS]

'.-...:.:. Bdid  Joasch  FID Vaww. Optizne. fiodan | fisle
Dle(a-® (%) S| el sl ol 38wl

| Lrafi [Standard ]
[+ " FROFTAUS DE

SESS - RERTEN § (e ]

= Bl STWATIC 403

= - SIMATIC P Baxed Comtrel 2004
# B SINATIC FC Siation

oy m

£ i |
S —
FEOFIBUE-DF alsves Ecx j

ali
SINATIC ST, AT, and OF (
A SEibuLed rack)

Fress FL eo met Help.

Figure 5
6. Here you can find your equipment in the right side of the window/PROFIBUS DP/Additional Field

Devices/Converter/GT100-DP-RS/, as Figure 6 shown:
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SR-APROFIELS IIF
-] Additional Field Dewices
EID Feneral
=] CONVERTER
=g GT100-DE-ES
Imiwersal module
Status/Control (Optional)
4 Yords Input, 4 Words Output
8 Words Inmput, & Words Output
16 Yords Input, 16 Words Output
32 Words Input, 32 Words Output
B4 Words Input, B4 Words Output
Evte Input
ford Input
Yords Input
Evte Output
Word Output
Words Output
Words Input Consistent

Words Inmput Consistent

[ T S R R e R

Words Input Consistent
----- 16 Words Input Consistent
2 Words Output Consiztent
4 Yords Output Consiztent
& Words Output Consistent

16 ¥Words Output Consistent

Figure 6

7. Set PLC rack, double click the “Hardware Catalog\SIMATIC 300\RACK-300\Rail”, as Figure 7 shown:
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E{a:Hw Config - [SIMATIC 300{1) {Configuration) -- T_MODBUS] oy ] 5]
E“] Station  Edit Insert PLC Wiew Options MWindow Help . =) ll
D228 %8| = 2/dda [DE]% v
= e =15 |
Find: | nﬂ i
A Brofil  [Standerd =l
3
+ ~ mlacrsdIm = |
: {3 cPU 314c-2 IP
[ Properties - PROFIBUS interface DP {RO/52.1} X[V 314C-2 PeP
7 U 315
) o | General — Farameters | U 315-2 DF
BEST 315-ZAFO0-0ABD
hddress: q - If a subnet is selected, EEST 3L5-ZAF01-0ABD
the next availahle address is S N e
BEST 315-ZAF03-0ABD
BEST 315-24F82-0ABD
BEST 315-ZAFE3-0ABD
Subnet

<
:I:l m) Uk

Hew. ..

Properiies
Delete

e Module Order zonber

[ = ]

BEST 315-ZAGL0-0ABO
BEST 315-ZAH14-0ABO
U 315-2 PH/IF

1 315F-2 IF

1 315F-2 PH/IF
T 316

1 316-2 0P

T 3172

U 317-2 FH/IF
T 317F-2

U 31TF-2 FH/DF
U 318-2

T 319-3 F¥/IF

Cancel Help |

0 CFU 319F-3 PR/DP
{21 CPU R14
{23 cru nr

{1 m-z00

| B Gateway =l
BEST 315-ZAFO0-0ABD - £<|
Work memory 45 KB: 0.3 msf1000 instructions: MPI + DF =

connections: for multi-tier configuration up to 32

= ||| | @] | e || ra]

i

Press F1 to get Help,

Figure 7

modules

[ [ [cha

8. Set CPU module and select the corresponding device type and the occupied slots.

9.

Create PROFIBUS DP network and set PROFIBUS DP: Click New -> Network settings. Select DP and select

a baud rate such as 187.5Kbps. Then select “OK”. Double-click it. As Figure 8 shown:
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[SIMATIC 300(1) {i
BLC  Wiew

nfiguration)

Wl Seation

im

it Insert Options  Window  Help

—loix|
gl

D28 i g |+a dha@o %8

Properties - PROFIBUS interface DP (RO/SZ.1

General  Parameters |

General Hetwork Settings |

Properti New subnet PROFIBUS

iz

Find: |

Erofil [Standard

x|fu arac-z per
U 315
U 315-2 DF
BEST 315-2AFO0-0ABO
 X|BEST 315-2AFD1-0ABD
EST 315-2AF02-0AB0
EST 315-2AF03-0AED
EST 315-2AF52-0AB0

=)

Hi ghest FROFIEUS
hidress:

™ Chenge

Transmission Rate:

4] |
:I:l m) Uk

3 Wodule

Brofile:

Order number

User-Tefined

EST 315-2AF83-0AE0
EST 315-2AG10-0AB0
EST 315-2AH14-0AE0
315-2 FH/DP

315F-2 DF

315F-2 PH/DF

316

318-2 IF

3172

317T-2 EN/IE

J1TF-2

3LTF-2 PW/TF

31e-2

319-3 FN/IE

Options. ..

<}

Bus Parameters. .|

319F-3 PH/TP
614

L= |

Cancel | Help L

] Gateway

J EEST 315-2AFO0-0AED

Work memory 48 KB; 0.3 ms/1000 instructions;

||| @|;]e]fr]e

NPT + TP il

|2 1«

4| [emnsctionsi for multitier configuration w to 52
n Tl | |modules =
Press F1 ko get Help, | | ithg 4
Figure 8
10. Select PROFIBUS DP Master address; As Figure 9 shown:
_ioi x|
_18] x|
Bix|
Find: | ﬁﬂ i
Profil [Stendard i
3 Select PROFIBUS Address o E=E £
4 +-(1] CPU 314 IFM -]
5 {1 CPV 314C-2 TP
& Properties - PROFIBUS interfzce DP (R.g/52.1) x|[2 crv atacz per
7 |1 cPur 315
B T General  Farameters [ ] CPUr 315-2 DF
FI BEST 315-2AF00-0ABD
Address: If a subnet is selected, 8] £EST 315-2AF0L-0ABD
L the next available address is I8 eEsT 315 2apoz-oa0

Transmizsion rate: 187.5 Ebps

Subnet:

315-2AF03-0ABD
315-2AFG2-0AB0
G15-2PAFG3-0AED
315-2AF10-0AB0

not networked ——-
1

1]

:I:l 0 VR

s Module

315-2AH14-04E0
| 7] CPUr 315-2 FH/DE

[] CPUr 315F-2 IF

[ CPIr 315F-2 PH/DP

{] CFUT 316

[ ] CPV 316-2 DP

1 crvoa1T-2

[ ] CPU 317-2 EH/DE

1) CPUr 317F-2

{] CPU 317F-2 FH/DP

Properties
Delete

Order numbe

O

Cancel Help

[ cPv a1e-2
|7} CPUr 319-3 FH/DE

L] CPU 319F-3 FH/DP

BEST 315-ZAF00-0AED

Work memeory 45 KB: 0.3 ms/1000 instructions:
comnmections; for mulbi-tier configuration up te 32

1% Y Y Y ) ) I

n

Press F1 ko get Help.
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Figure 9
11. Configure GT100-DP-RS slave station into PROFIBUS DP network, and map the input and output data block

to S7-300 or other controller’s memory, As Figure 10 shown:

FUHW Config - [SIMATIC 300(1) (Configuration) -- T_MODBUS] o =] eS|
E“] Station Edit Insert PLC Mjew Options ‘Window Help = Iﬁllﬂ

022 % & ee aaldo 2 e

= olx|
1 FS 307 5A PROFIBUS (1): DP master system (1) Bind: | Elﬂ'l
2 CPU 315-2 DP J T Brofil [Stamdurd =
Iz oF
3 = PROFIEUS TP ]
4 Br T e E1-(E3 Additional Field Devices
5 L——_ID General
B ~— =] CONVERTER
7 g GTI00-TF-ES
B [ Tniversal module
9 Status/Control (Optionall
10 4 Words Input, 4 Words Output
11 § Words Input, & Words Output
16 Words Input, 16 Words Output
Drag the data to the left 32 Words Input, 32 Words Output

B4 Words Input, B4 Words Output
1 Byte Input

1 Word Input

8 Words Input

1 Byte Output

1 Word Output

8 Words Output

2 Words Input Consistent

bottom of the table.

-
1| | »

:I:l (@)  GT100-DF-ES

4 Words Input Consistent
8 Words Input Conzistent

16 Words Input C istent
B DF ID ... | Order Wumber / Designation | I Add... |0 Address | Comment | : wQ:z:Durt‘Pzt CZE::t::t
1] AT 5 Words Input, & Words Output |272... 257 ﬂ 4 Words 01 tp A : chart
7 FAD —5 G Fords Input, § Fords Dut) AN — TR b s
> § Words Output Consistent
3 16 Words Output Consistent
Init
4 e E
5 L
: _|
L E
Press F1 to get Help, Chg 2
Figure 10

Operation is divided into two steps: the first step is to drag GT100-DP-RS into the network configuration on
the upper left and drag on the PROFIBUS DP bus The mouse will change its shape, which is to say it can be
placed. The second step is to drag data block into the data mapping table at the bottom left, then the table will
change to green, which is to say it can be placed and map corresponding bytes to the PLC memory.

Notel: When requiring full word, drag data block to the left bottom of table where requires the full word data
block, the location must correspond to converter memory area where need full word in SST-MP-CFG
configuration software.

Note2: The setting of PROFIBUS DP slave station address must be consistent with the settings of configured
button!

12. Compile and download the configuration into PLC.
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